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About This Document

Reference Documents
This reference guide refers to the following documents: 

Conventions
Keystrokes are indicated as follows:

Typeface conventions used include:

Part Number Document Title

70E-20688-03 Spectrum24 AP-4121 Access Point Product Reference Guide

70E-20706-03 Wireless LAN Adapter Models LA-4121 PC Card & LA-4123 PCI Adapter 
Product Reference Guide

70E-20709-03 Spectrum24 Plus Pack User Guide

ENTER identifies a key.

FUNC, CTRL, C identifies a key sequence. Press and release each key in turn.

Press A+B press the indicated keys simultaneously.

Hold A+B press and hold the indicated keys while performing or waiting for another 
function. Used in combination with another keystroke.

<angles> indicates mandatory parameters in a given syntax.

[brackets] for command line, indicates available parameters; in configuration files 
brackets act as separators for options.

GUI Screen text indicates the name of a control in a GUI-based application.

Italics indicates the first time a term is used, a book title, variables, and menu 
titles.

‘single quotes’ indicates the exact setting for a parameter.

Screen indicates monitor screen dialog. Also indicates user input. A screen is
the hardware device on which data appears. A display is data arranged
on a screen.
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This document uses the following for certain conditions or types of information:

Indicates tips or special requirements.

Indicates conditions that can cause equipment damage or data loss.

Indicates a potentially dangerous condition or procedure that only Symbol-

trained personnel should attempt to correct or perform.

Terminal indicates text shown on a radio terminal screen.

URL indicates Uniform Resource Locator.
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Chapter 1 Preparing for a Spectrum24
Site Survey
Installing a Spectrum24 wireless network begins with conducting a site 
survey. A site survey involves using the Spectrum24 Site Survey utility to 
determine the physical requirements for a site-specific Spectrum24 wireless 
network. A site survey analyzes the installation environment and provides 
users with recommendations for equipment and placement.

Use the Spectrum24 Site Survey utility to determine the placement of access 
points and antennas, as well as the number of devices necessary to provide 
optimal service. The facility can be a warehouse, manufacturing plant, office 
building or retail store. 

Only the Symbol site survey team or other qualified site survey technicians 

should use the Spectrum24 Site Survey utility.

In the installation of the Spectrum24 network, complete coverage could 
require multiple antennas. If the facility is small, or the coverage area is
free from physical obstructions, one access point and antenna could be 
sufficient. However, a dual-antenna access point could be required to 
provide additional diversity if performance and signal reception issues exist.

If unfamiliar with the Spectrum24 wireless infrastructure and the components 
that comprise it, refer to Appendix A “Spectrum24 Overview” for an overview 
of Spectrum24 technology.
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Preparing for a Spectrum24 Site Survey
1.1 Inspecting the Survey Area 
During the planning stages of the site survey, a representative from the site 
survey team visits the proposed Spectrum24 radio coverage site. As a 
standard practice in the site survey consultation, the representative gathers 
facility drawings and completes a Site Survey Requirements document and a 
site survey questionnaire. The representative documents the wiring used 
within the facility (10BaseT, 10Base2, fiber optic) and assesses its 
applicability to Spectrum24 components. 

Several trial installation areas should be selected. The site survey team 
analyzes each proposed installation area to document radio transmission 
constraints and to develop preliminary access point placement alternatives to 
be tested during the actual site survey. The findings from the initial site 
inspection should be documented in a Site Survey Request Form and serve as 
the outline of the site survey. 

The following variables should also be considered in the site survey 
requirements definition:

• RF systems already in use

• availability of lifts for mounting access points

• location of host system(s)

• available AC power

• interfering metal fire breaks and wall structures

• availability of customer technical personnel to answer questions during 
the survey 

• doorways and passages causing RF propagation.

The completion of the RF Site Survey Requirements document is a 
coordinated effort between the site survey team and the customer 
management team.
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Preparing for a Spectrum24 Site Survey
The RF Site Survey Requirements document does not identify potential 
installation constraints within the customer site, nor does it recommend 
access point and antenna placement location. The RF Site Survey 
Requirements document represents a preliminary overview of the
customer site used as a baseline for refining site survey requirements. 

1.1.1 Environmental Radio Coverage Considerations

The site survey team selects trial Spectrum24 component installation areas 
away from transformers, heavy-duty motors, fluorescent lights, microwave 
ovens, refrigerators and other industrial equipment. Areas with excessive 
moisture, heat and dust are inappropriate for staging a Specrum24
wireless network.

Signal loss can occur when metal, concrete, walls or floors block access
point transmission areas. Spectrum24 AP antennas are trial-mounted in 
open areas or added to an existing access point to boost the Spectrum24 
coverage area. 

The positioning of an access point depends on the floor plan of the site.
The site survey team makes access point and antenna placement 
recommendations based on the following installation site variables: 

• outdoor or indoor installation site

• large or small proposed radio coverage area

• wide or narrow proposed coverage area

• open coverage area or area with documented obstructions.

General Guidelines

Site surveys for direct-sequence spread spectrum devices require 
experimentation with different antennas at various angles. Placing a 
directional antenna in a vertical position can often minimize multi-path 
problems in a direct-sequence environment.
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Preparing for a Spectrum24 Site Survey
In an indoor environment the range at 11 Mbps is about 60 feet, with some 
data packets transmitting at 5.5. Mbps. The range at 5.5 Mbps is between 
100 - 120 feet, with some data packets transmitting at 2 Mbps. In an open 
air environment, the range is between 600 and 1200 feet. These 
measurements were obtained with antenna diversity enabled.

Do not locate access points near corners, against walls, against metal walls 
or inside plenums.

1.1.2 Channel Interference Considerations 

Spectrum24 access points require careful survey area testing to ensure
radio transmissions do not overlap. If necessary, adjacent access points 
require omnidirectional and directional antennas to optimize radio
coverage in conflicting coverage areas and neighboring cells with the
same direct-sequence channel. 
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Preparing for a Spectrum24 Site Survey
1.2 Antenna Placement Considerations
Radio coverage requirements relate directly to installation site constraints. 
With an omnidirectional antenna, the radio range of the access point could 
have a radius up to 1000 feet (303 meters) in open areas. However, in office 
or retail environments, obstructions can reduce the coverage to a radius of 
180 to 250 feet (54 to 76 meters). Use a directional antenna for sites that 
require longer distances over relatively narrow areas. The coverage area is 
also referred to as a cell.

An omnidirectional antenna transmits and receives radio waves
in all directions. The coverage area is circular with the antenna at
the center. Omnidirectional antennas are also referred to as whip or
low-profile antennas. 

Directional antennas transmit and receive radio waves off the front of the 
antenna. The power behind and to the sides of the antenna is reduced.
The coverage area is oval with the antenna at one of the narrow ends. 
Typical directional antenna beam width angles are from 90°, (somewhat 
directional), to as little as 20°(very directional). A directional antenna directs 
power to concentrate the coverage pattern in a particular direction. The 
antenna direction is specified by the angle of the coverage pattern called the 
beam width.

The decibel (dB) represents the unit of comparative power for assessing radio 
signal strength. For Spectrum24 antennas, addition and subtraction can 
calculate total dB loss. The abbreviation dBm is the decibel referenced to
1 milliwatt (mW).

Mathematically:

     dB = 10 LOG Pr where Pr is the power ratio (P1/P2)

when calculated against 1 mW then:

     dBm = 10 LOG P/.001W
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Preparing for a Spectrum24 Site Survey
Example:

     P = 2W, then Pr = 2W/.001W = 2000 

     dBm = 10 x LOG 2000 = 10 x 3.3 = 33

therefore, a 2W transmitter equates to 33 dBm.

To convert dBm back to a power level the inverse function is used that is:

PmW = 10(dBm/10)

For directional antennas, signal strength (gain) can be increased by diverting 
power from the non-coverage areas and redirecting it into the area where 
coverage is required.

When directional antenna power is concentrated, RF coverage increases 
within the beam width. The increase in RF coverage within the beam
width is called antenna gain, and is measured in dB. A good guideline is a 
2.5% increase in range for each 1 dB increase in antenna gain for indoor 
sites, and a 5% increase in range for each 1 dB increase in antenna
gain for unobstructed outdoor sites. Actual results vary depending on
site obstructions.

Directional antennas are recommended where the coverage area is confined 
to an area such as a hallway or corridor. Symbol recommends 
omnidirectional antennas in areas where the coverage area is in an open 
area with little interference.

The final location of access point antennas is critical to the successful 
operation of the system. When conductiong the survey, consider the exact 
conditions in the installation area. These conditions include all losses due to 
cabling and connectors. 
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Preparing for a Spectrum24 Site Survey
1.2.1 Diversity Reception

Diversity reception is the use of two antennas attached to a single access 
point. A second antenna can improve radio reception. The second antenna is 
attached to the AP SECONDARY ANTENNA connector and is used only for 
receiving radio signals. The primary antenna is used for both transmitting 
and receiving.

The principle behind diversity is to overcome interference or fading by using 
the signal with the strongest reception.

1.2.2 Site Electrical Considerations

Spectrum24 access points draw power from wall outlets. Access point 
performance is subject to degradation due to inherent or random electrical 
problems or site-specific disturbances.

The following Spectrum24 access point electrical installation alternatives are 
listed from optimal for an installation area to preferred for that area:

1. isolated ground circuit with an online, uninterruptable power supply (UPS) 
that also acts as a filter and surge suppressor 

2. isolated ground circuit with a surge suppressor 

3. dedicated circuit with a UPS 

4. dedicated circuit with a surge suppressor 

5. nondedicated circuit with a UPS 

6. nondedicated circuit with a surge suppressor 

Symbol recommends items one through four when using a Network 
Controller Unit. Deviation from one of these four items can cause data loss 
and serious transmissions problems.

Symbol does not recommend configuration items five and six due to the 
nature of a nondedicated circuit. A nondedicated circuit contains open 
receptacles and the load and type of use cannot be predicted at the time
of installation. 
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Preparing for a Spectrum24 Site Survey
Ensure the availability of power to an access point 24 hours a day.
Symbol recommends access point power never be provided from an Energy 
Management System.

If it is necessary to use a nondedicated circuit, Symbol recommends that the 
circuit not support:

• hard wired devices

• devices with components intended or known to produce heat such as 
space heaters, laser printers, heat guns and soldering irons

• single device drawing more than 20% of the rated value of the circuit

• devices drawing more than 60% of the rated circuit value. 

1.3 Requesting a Spectrum24 Site Survey
Once the customer has been consulted, their needs identified, environmental 
antenna requirements considered, site electrical constraints identified and 
several trial Spectrum24 installation sites selected, a survey team 
representative completes the Site Survey Request Form.

The Site Survey Request Form contains detailed information about the 
customer, the Symbol Sales Associate representing the customer, an updated 
floor plan of the customer facility, host operating system considerations and 
the quantity and type of Spectrum24 components being installed.

The site survey team reviews the Site Survey Request Form to decide whether 
to approve the proposed Spectrum24 installation based on its likelihood to 
succeed. Once the Site Survey Request Form is generated, customer final 
approval is required before formally scheduling the site survey.

1.3.1 Scheduling the Site Survey

The site survey is scheduled as soon as the site survey team and the customer 
approve the Site Survey Request. 
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Chapter 2 Using the Site Survey Utility to 
Conduct a Site Survey
Use the Spectrum24 Site Survey utility to establish a two-way data network 
using both stationary and mobile devices at various points within the 
proposed radio coverage area. Assess AP signal strength using various 
antenna and AP configurations to determine areas requiring additional or 
higher performance antennas. 

The Spectrum24 Site Survey utility runs under Windows 95/98, NT
and 2000. 

1 a
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Using the Site Survey Utility to Conduct a Site Survey
2.1 Installing the Spectrum24 Site Survey Utility 
A Spectrum24 Site Survey requires the site survey utility be loaded on the 
Spectrum24 mobile devices and the desktop computer used in the survey.

2.1.1 Installing the Site Survey Utility from a CDROM

To install the Spectrum24 Site Survey utility from CDROM:

1. Insert the installation CDROM in the computer CD drive.

2. Click Start and select Run.

3. Enter x:\Setup.exe

where x represents the letter assigned to the CD drive.

4. Click OK.

5. Complete the installation following the instructions provided with the 
Spectrum24 Site Survey utility.

6. Select Yes when asked if backup copies of replaced files are required. 

Selecting Yes invokes the site survey utility uninstall feature for
possible use. 

The Spectrum24 Site Survey utility installation is completed. Launch the 
site survey utility by clicking on the program icon appearing on the 
Windows desktop.

2.1.2 Copying the Site Survey Utility from the Symbol Web Site to a 
Desktop Computer

To copy the Spectrum24 Site Survey utility from the Symbol Web site:

1. From a desktop computer, go to the Symbol Web site
(http://www.symbol.com/services/downloads/download_spec24.html) 
and select the Spectrum24 Site Survey utility.

A File Download window appears prompting the user to run the utility 
from its current location or save it to disk.

2. Check the Save this program to disk option and click OK.
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Using the Site Survey Utility to Conduct a Site Survey
A Save As window appears prompting the user to enter the destination 
for the Spectrum24 Site Survey Utility.

3. Select the drive letter assigned to the desktop computer hard drive and 
click Save. 

The zipped Spectrum24 Site Survey utility files copy to the desktop 
computer hard drive.

4. Extract the Spectrum24 Site Survey utility by double-clicking the 
Spectrum24 Site Survey utility icon and completing the instructions 
provided by the program.

Once the utility has been extracted to the desktop computer the utility 
installation is complete.

2.2 Creating a Trial Spectrum24 Wireless Network
Before using the Spectrum24 Site Survey utility, a Spectrum24 wireless LAN 
infrastructure is created to test Spectrum24 component radio signal strength.

In addition to the Spectrum24 Site Survey utility, the following equipment is 
required to create a Spectrum24 wireless network:

• Spectrum24 access points

• digital camera

• distance measurement wheel

• directional and omnidirectional antennas

• Spectrum24 MUs with extra batteries

• Access point battery.

To install a trial Spectrum24 wireless network:

1. Connect the access point antenna(s). 

2. Mount the access points.

Mount access points at the locations recommended on the floor plan 
drawing. Start with the most difficult coverage area first. Position the 
access points so the antennas are not obstructed. 

3. Power on the access points. 
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Using the Site Survey Utility to Conduct a Site Survey
Use battery power if an AC wall socket is not convenient.

4. Observe access point LED behavior. 

Observe the LEDs to verify normal boot operation. After the boot cycle is 
complete, the STATUS LED flashes approximately once every second to 
indicate the access point is operating properly.

Spectrum24 component installations differ depending on the device 
installed. Refer to the documentation shipped with each Spectrum24 
component to ensure proper installation and configuration.

5. Power on the Spectrum24 MUs used for the site survey.

The Spectrum24 Site Survey utility should already be loaded on the 
Spectrum24 mobile devices and desktop computer used to perform
the survey.

When the device is powered on it displays a message indicating the 
access point is not connected to a boot server. This is normal since the 
access point is not yet connected to an Ethernet network.

6. Set the access point and MU Network IDs. 

Set the MU(s) and access point to the same Net ID. Normally, the access 
point default value 101 is used.

A Spectrum24 wireless network now exists and can be tested for radio 
transmission effectiveness with the Spectrum24 Site Survey utility. 

2.3 Starting the Spectrum24 Site Survey Utility
To launch the Spectrum24 Site Survey utility:

1. Click Start and select Programs.

2. Click Symbol Wireless and select SpectrumSoft Site Survey.

3. Click Site Survey and select Site Survey again.
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Using the Site Survey Utility to Conduct a Site Survey
The Site Survey utility Welcome dialog box displays.

Use the Welcome dialog box to open an existing site survey area workspace, 
create a new workspace, create a new workspace from an existing site survey 
area workspace (a template or a .sst file) or open a recently used workspace. 

If an existing site survey workspace is opened containing one or more survey 
areas, the Site Survey Test dialog box displays. Use the Site Survey Test 
dialog box to specify the ICMP test parameters for the survey area. If an 
existing survey workspace does not have a survey area defined, the Site 
Survey dialog box displays. Use the Site Survey dialog box for entering
the site survey area name, surveyor and description. The Site Survey Test 
and Site Survey dialog boxes are described in greater detail in the sections 
that follow.

Closing the Welcome dialog box enables the File, Edit, View, Area and 
Help pull-down menus. Use these menus to create a new site survey, view 
radio coverage areas within an existing site survey template, run a ping test 
for a survey area, display and configure the Edit menu property pages and 
display help information for the usage of the utility.
Spectrum24 Site Survey Administrators Guide 13



Using the Site Survey Utility to Conduct a Site Survey
2.4 Navigating the Site Survey Utility File Menu
Use the File menu to create a new survey area workspace, open an existing 
survey workspace, define a new survey area, save the survey workspace, 
work with a report, import survey workspace data and display recent
survey information.
14 Spectrum24 Site Survey Administrators Guide



Using the Site Survey Utility to Conduct a Site Survey
2.4.1 Creating a New Site Survey

Select New Site Survey from the File menu or click on the application 
toolbar button resembling a sheet of paper to open a Site Survey dialog 
box. Use the Site Survey dialog box to enter the site name, surveyor and 
description. If a workspace is open, the user is prompted to save the existing 
workspace first. Click OK to save the new workspace information. The status 
bar at the bottom of the screen displays the new workspace name.

2.4.2 Selecting an Existing Site Survey

Select Open Site Survey from the File menu to open a standard Windows 
dialog box displaying files with the extension.ssw. If an invalid file is read,
an error message displays, otherwise, a progress dialog box displays and
the workspace is loaded. The Site Survey Test dialog box displays if the 
workspace has at least one defined area. The Site Survey Area dialog box 
displays if the existing workspace does not have a defined area. The status 
bar displays the workspace and area name.
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Using the Site Survey Utility to Conduct a Site Survey
2.4.3 Defining a New Site Survey Area

Select New Area from the File menu to display a Site Survey Area dialog 
box. Use the Site Survey Area dialog box to enter the area name and 
description. The Delete button is grayed when defining a survey area. The 
Test Name field lists the tests defined for that area. Add a new test by clicking 
the ellipsis (…) button. An error message displays if the Area Name field is 
left blank or the name of an existing area is entered. The area name displays 
at the bottom of the screen.

2.4.4 Save/Save As

Select Save from the File menu or click on the application toolbar 
resembling a diskette to save the open workspace using the existing
survey name. Select Save As from the File menu to save the survey
using a different name.
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Using the Site Survey Utility to Conduct a Site Survey
2.4.5 Importing a Site Survey

Select Import from the File menu to display an Import Areas and Tests 
dialog box. Use the Import Areas and Tests dialog box to import survey 
areas and/or tests from another survey workspace. Select Import Areas
and/or Import Tests to replace existing survey areas and tests or to add
new ones. Click the Import button to display a standard Windows dialog
box displaying files with the extension .ssw.

2.4.6 Working With Reports

A Spectrum24 Site Survey Report can be generated, edited and printed for 
each site survey workspace. The Spectrum24 Site Survey Report is a 
WordPad document generated when the survey is complete. The report can 
be edited as a typical WordPad document. The template for a new report has 
the filename Site Survey Results.doc and is installed in the same directory as 
the program executable. 
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2.4.7 Displaying Recent Site Surveys

Select Recent Site Surveys from the File menu to display the last four site 
survey workspace files created or accessed. Selecting any workspace in the 
list loads that workspace. If there is at least one Area defined for the 
workspace, the Site Survey Test dialog box displays. The status bar at the 
bottom of the dialog box displays the status, filename, area name, and 
workspace name. If a workspace is already open, the user is prompted to 
save the existing workspace first. 

2.5 Navigating the Edit Menu   
The Site Survey Edit menu contains Site Survey, Area and Default Settings 
pull-down menus. It also contains items for WordPad editing. 
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Use these menu items to edit an open Spectrum24 site survey, display a list
of coverage areas within the workspace and use the Setup, Meter Settings, 
Sounds and Logging property pages to configure surveyor, system sounds 
and test data logging information. Use the menu items below Default 
Settings to edit the report file. 

2.5.1 Editing Existing Site Survey Information

Select Site Survey from the Edit menu or select the application toolbar button 
resembling an open folder to display the Site Survey dialog box. Use the
Site Survey dialog box to enter the site name, surveyor, and description.
If a workspace is already open, the user is prompted to save the existing 
workspace. Click OK to save the edited workspace information.
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2.5.2 Editing the Properties of an Existing Site Survey Area

Select Area from the Edit menu to display the Site Survey Area List dialog 
box. Use the Site Survey Area List dialog box to display a list and description 
of survey areas. Select an area and click Edit Area to display the Site Survey 
Area dialog box. Add new tests and survey area descriptions as needed. 
Click OK to save the changes to the site survey workspace. Click Delete to 
remove the area from the current site survey workspace. 
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2.5.3 Editing the Default Settings Property Pages

Select Default Settings from the Edit menu or click on the application 
toolbar resembling a hand pointing to a card to access the Setup, Meter 
Settings, Sounds and Logging property pages. Use these property
pages to change default settings for the current site survey workspace.

Setup Property Page

Select the Setup property page to change the following default site survey 
workspace information: 

Surveyor. Enter the surveyor name in the Surveyor field to automatically 
update the New Site Survey dialog box. Click OK to save the updated 
surveyor name in the registry for subsequent surveys.

Auto Rerun. Run the Site Survey utility in either automatic or manual mode. 
If Auto Rerun is checked, the test suite runs for the rerun count or until the 
surveyor stops the tests.

ICMP Host Addr. Enter an ICMP Host Adrress in the field provided.
The default address is the default address of the AP.
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If a pre 4.0 version of Internet Explorer is running on a Windows 95 (Rev B) 
system, the Setup Property Page does not display. Update Internet Explorer to 
version 4.0 or greater to resolve this problem. 

Ping Count. Enter the number of pings to be transmitted during the ping
test in the Ping Count field. The default Ping Count is 100, with a maximum 
of 2000. 

Rerun Count. Enter the number of times the ping test is transmitted
in the Rerun Count field. The default Rerun Count is 100. The rerun can
be Continuous.

Packet Size. Enter the packet size transmitted during the ping test in the 
Packet Size field. The default Packet Size is 128 bytes, with a maximum of 
1472 bytes.

Threshold Time. Enter the maximum acceptable time to send out and 
receive the total number of pings for each test in the Threshold field. Choose 
a Threshold Time from1 milli-second to 100,000 milli-seconds. The default 
Threshold Time for 100 pings is 3500 milli-seconds.

Override All Test ICMP Host Addresses. Check this box to use the ICMP 
host address entered on this page for all tests. Checking this box does not 
replace the host address saved for each test.
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Meter Settings Property Page

Select the Meter Settings property page to set bounds (thresholds) for the 
signal quality gradient bars in the Round Trip, Missed Beacon and Transmit 
Retry fields. The circular RTT Avg, Missed % and Retry % indicators on the
Site Survey Test dialog box show green if the average of the previous tests 
(20 tests for RTT Avg, 40 tests for Retry % and 20 tests for Missed %) is below 
the lower threshold. 

The circular indicators on the Site Survey Test dialog box show red if the 
average of the previous tests is above the upper threshold. Test results 
between the bounds set on the Meter Settings property page result in yellow 
displays on the circular indicators on the Site Survey Test dialog box. The 
circular indicators show green if the test results are below the lower bounds. 
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Sounds Property Page

Select the Sounds property page to change the following default site survey 
workspace information:

Play on Timeout. Select Play on Timeout to emit an audible timeout tone 
every time a ping test timeout is reached.

Play on Roam. Select Play on Roam to emit an audible roaming tone every 
time an MU roams between APs.

Play on Threshold. Select Play on Threshold to emit an audible threshold 
tone every time the threshold time is met or exceeded.

Play on Test Complete. Select Play on Test Complete to emit an audible
test complete tone every time a suite of ping tests has been transmitted.

The default for the Sounds property page is all four sounds enabled.
Set the volume level and/or sound by using the standard Windows
Control Panel Volume and Sounds applet or the Sounds task tray applet.
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Logging Property Page

Select the Logging property page to change the following default site survey 
workspace information:

Enable Logging. If unchecked, no logging takes place during the ping tests. 
The logfile consists of the date, time, and test settings (area name, test name, 
packet size, rerun count and signal quality boundaries). System messages 
and notes (if any) are also added to the logfile. If the user has chosen to 
record real-time test noise data and/or data points, they are also added to 
the logfile.

Clear Log contents before each test. Select Clear Log contents before each 
test to automatically clear the content of the log before a test suite is run.

Confirm before log contents are cleared. If checked, the surveyor is 
prompted whether the logfile should be cleared before the test suite is run.
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2.6 Navigating the View Menu
The Site Survey utility View menu contains Adapter Info, Areas, Known APs, 
Noise Meter, Signal Quality and Generate Report pull-down menu items.

Use the menu items to view Spectrum24 WLAN adapter driver and Firmware 
data, site survey areas, access points within range of a target Spectrum24 
mobile device and a graph depicting MU signal quality and to append the 
logfile to the report file. The status bar at the bottom of the main window can 
be displayed or hidden by checking or unchecking Status Bar. The tool bar 
buttons can be displayed or hidden by checking or unchecking Toolbar.
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2.6.1 Viewing Adapter Info

Select Adapter Info from the View menu to display an Adapter Information 
dialog box. Use the Adapter Information dialog box to display Spectrum24 
WLAN adapter driver and Firmware version, adapter type and Firmware 
type, supported data rates and ESSID. The information is view only and 
cannot be modified. 
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2.6.2 Viewing Site Survey Area Info

Select Areas from the View menu to display the Site Survey Area List dialog 
box. Use the Site Survey Area List dialog box to display a list and description 
of survey areas. Select an area and click Edit Area to display the Site Survey 
Area dialog box. Add new tests and survey area descriptions as needed. 
Click OK to save the changes to the site survey workspace. Click Delete to 
remove the area from the current site survey workspace. 
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2.6.3 Viewing Access Point Info

Select Known AP’s from the View menu to display the recognized access 
points in range of the target MU. Use the Known AP’s dialog box to view the 
access point BSS ID, number of associated MUs, MU type and status and 
data rate. An icon next to each access point indicates whether the access 
point is mandatory or preferred and whether or not the access point is 
associated. A list of access points within range of the MU is also shown. 
Select an AP and right click to change the AP type to Mandatory or Roaming. 
Click the Rates button to display the Transmission Rates dialog box. Use the 
Transmission Rates dialog box to set the transmission rate to 1 Mbit, 2 Mbit, 
5.5 Mbit or 11 Mbit. Checking multiple rates defaults the MU to a lower rate 
f the higher rate AP association cannot be established. If no rate is checked, 
the transmission rate is that of the Spectrum24 wireless LAN adapter.

The Rates button is only enabled in frequency-hopping systems. It is not 
available in direct-sequence systems. 
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2.6.4 Viewing Mobile Unit Noise Info

Select Noise Meter from the View menu or click the application toolbar 
button resembling a colored bar graph. One of two graphs
display depending on the type of network equipment being used.

Frequency-Hopping Spread Spectrum

In a frequency-hopping spread spectrum network a graph of Relative Signal 
Strength Indicator (RSSI) values and channel numbers displays. Use the 
Noise Meter dialog box to view the MU BSS ID and the RSSI minimum, 
maximum and average values. The RSSI values displayed in the graph are 
continuously updated with the last six received values displayed in blue. Click 
Reset to reset the graph to zero and click Go to begin a new display as RSSI 
values are received. Check Record Real Time Data to append RSSI values to 
the logfile. 
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Direct-Sequence Spread Spectrum

In a direct-sequence spread spectrum network two graphs can display.  For 
adapter version 1.0, a graph illustrating channel quality, average signal level 
and average noise level displays. The channel quality ranges from 0 to 31 
and is calculated as the difference between the average signal level and the 
average noise level. These levels are averages calculated over time. The 
channel quality minimum, maximum and average values are displayed and 
the graph is continuously updated. Click Reset to reset the graph to zero. 
Click Go to begin a new display as channel quality values are received. 
Check Record Real Time Data to append the values to the logfile. For 
adapter version 2.0 or above, only the average signal level displays. The 
scale remains 0 to 31. 
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2.6.5  Viewing Mobile Unit Signal Quality Info

Select Signal Quality from the View menu to display the real-time 
percentage of missed beacons, the percentage of transmission retries
and the percentage of CRC errors. Use the Signal Quality dialog box to 
display the strength of the radio signal transmitted by an access point.
This information is useful in determining if the trial site survey access point 
placement locations are effective for providing radio coverage to the 
proposed radio coverage area. 
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2.6.6 Generating the Site Survey Report

A Spectrum24 Site Survey Report can be generated for each site survey 
workspace. The report contains an overview of the survey, installation 
considerations, warranty information, survey findings, equipment placement 
recommendations and a detailed results section. 

The report is a Microsoft WordPad document that can be generated when the 
survey is complete. The report can be edited and printed using the Cut, 
Copy, Paste and Print application toolbar buttons. The template for a new 
report has a Site Survey Results.doc filename and is installed in the same 
directory as the program executable. 
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2.7 Navigating the Area Menu
The Site Survey utility Area menu contains New, Select, Clear Log Contents, 
Edit Note and Run ICMP Test and Run Throughput Test menu items.

 

Use the menu items to create or edit a site survey area, view the settings of
a survey area, clear a site survey log, add notes to the survey log, run ICMP 
tests and run throughput (FTP) tests.
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2.7.1  Creating a New Survey Area

Select New from the Area menu to display a Site Survey Area dialog box. 
Use the Site Survey dialog box for entering a survey area name and 
description. If a workspace is already open, the user is prompted to save
the existing workspace. Click OK to add the area to the workspace.
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2.7.2 Selecting and Editing an Existing Survey Area

Click Select from the Area menu to display the Site Survey Area List dialog 
box. Use the Site Survey Area List dialog box to display a list and description 
of survey areas. Select an area and click Edit Area to display the Site Survey 
Area dialog box. Add new tests and survey area descriptions as needed. 
Click OK to save the changes to the site survey workspace. Click Delete to 
remove the area from the current site survey workspace.
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2.7.3 Clearing the Text File Log for an Open Survey Area

Use the Clear Log Contents option to delete the log contents for the active 
survey workspace.

2.7.4 Editing the Note File for an Open Survey Area

Select Edit Note from the Area menu to display the Note Editing
dialog box. Use the Edit Note option to add notes to the logfile of the active 
survey workspace.

2.7.5 Running ICMP Tests

Select Run ICMP Test from the Area menu or select the ICMP toolbar button 
to display the Site Survey Test dialog box. 

Use the Site Survey Test dialog box to specify ICMP test parameters. ICMP 
tests are ping tests assessing radio transmission roundtrip, delay time and 
transmission signal strength. Click Start Test to begin the test.
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Setting ICMP Test Parameters

Use the Site Survey Test dialog box to set the following ICMP test 
parameters:

Access Point. The Access Point field of the Site Survey Test dialog box lists 
the associated access point. Choose a different access point from the list of 
available access points by clicking the ellipsis button.

Area. Define a new survey area by selecting “(New)” from within the Area 
pull-down list and clicking the ellipsis button. 

Test. Use the Test pull-down list to display the tests defined for the 
workspace. Use the ellipsis button to enter new test settings or edit existing 
test settings.

Test Statistics. Use the Test Statistics field of the Site Survey Test dialog box 
to view the total roundtrip ping time, elapsed test time, tests remaining in the 
run, the number of test runs remaining, the transmit data rate, packets 
transmitted, packets received and the number of retries. A graph of RSSI (for 
frequency-hopping) or average signal level (for direct-sequence) displays. 

Four graphs on the bottom of the Site Survey Test dialog box display an 
average roundtrip time, missed beacon percentage, retry percentage, and 
threshold percentage. Bounds (thresholds) set in the Meter Settings property 
page establish the limits for the variables in the graphs. 

Results List Box. Use the Results List Box to view ping count, errors, 
cumulative retries, roundtrip time and missed beacons percentage. Scroll 
backward or forward in the list. The list box holds 1000 pings.

Start Test. Click Start Test to begin the ICMP test. Once started, the Start Test 
button changes to a Stop button. 

Edit Note. Click Edit Note to display a dialog box for entering notes for the 
test. Each note is added to the logfile.

Clear List. Use the Clear List button in Site Survey Test dialog box to clear 
the results list box.
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Test Totals. Click the Test Totals button to display the Site Survey Totals 
dialog box. 

Use the Site Survey Totals dialog box to display the time the tests were 
started and stopped, the number of tests run, number of re-runs, total 
roundtrip time, average roundtrip time, total number of timeouts and
the test completion status. Packet throughput information is summarized
as the number of packets sent and received and the data rates for each. 
These values are recorded in the logfile if logging is enabled.

Progress Bars. Use the gradient progress bars to view RTT Avg, Missed %, 
Retry % and the percent of threshold achieved during the test. The numerical 
value is displayed in white in the middle of each progress bar. The bars 
change color as the values approach the lower and upper bounds. Green 
indicates a value below the lower bound, yellow indicates a value between 
the bounds and red indicates a value greater than the upper bound. 

Percent of Threshold. The percent of threshold (established in the Setup 
property page) that the sum of the round-trip times are approaching.
The white number in the middle of the progress bar is the sum of the round-
trip times.
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Setting New Test Parameters

Select “(New)” from the Test pull-down list box in the Site Survey Test dialog 
box. Open the New Test Settings dialog box by clicking the ellipsis button 
(...) next to the Test pull-down list box.

Use the New Test Settings dialog box to enter a test name, define test packet 
sizes, select a test ping count, enable the test Auto Rerun, Sounds and 
Logging features, change host address information and display the Settings 
property pages. 

Test Name. Use the Test Name field in the New Test Settings dialog box to 
enter the test for the active survey area.

Packet Size. Use the Packet Size field in the New Test Settings dialog box
to enter a packet size for the ICMP test.

Ping Count. Use the Ping Count field in the New Test Settings dialog box to 
type in a ping count value for the ICMP test.

Threshold. Use the Threshold field in the New Test Settings dialog box to 
type in threshold value (in milli-seconds) for the ICMP test. This is the total 
round-trip ping transmission threshold. 
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Host Address. The host address entered in the Settings Setup property
page displays in the Host Address field. Change the host address value by 
typing it in.

Auto Rerun. Select the Auto Rerun option in the New Test Settings dialog 
box to enable the Auto Rerun test feature.

Enable Sounds. Select the Enable Sounds option in the New Test Settings 
dialog box to enable the Sounds feature.

Logging. Select the Logging option in the New Test Settings dialog box to 
enable the Logging feature.

Advanced. Click the Advanced button in the New Test Settings dialog box 
to access the Advanced Test Settings property pages for the active survey 
area workspace. Use the Settings property pages (Meter Settings,
Sounds and Logging) to change the default settings for the current site 
survey workspace.
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2.7.6 Running Throughput Tests

Select Run Throughput Tests from the Area menu or select the FTP toolbar 
button to display the FTP Test dialog box. 

Use the FTP Test dialog box to specify throughput test parameters. 
Throughput tests are File Transfer Protocol (FTP) tests. 

Setting Throughput Test Parameters

Use the FTP Test dialog box to set the following test parameters:

FTP Site Name. Use the FTP Site Name field to enter the IP address or site 
name of the FTP site.

Anonymous Login. Check the Anonymous Login checkbox to login without 
a username or password. 
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User Name. Enter the user name for the FTP site.

User Password. Enter the password for the FTP site. 

Get file from Site. Select the Get file from Site radio button if the file 
specified in the Get/Put Filename field is to be transferred from the site. 

Put file to Site. Select the Put file to Site radio button if the FTP file is to be 
transferred to the site.

Log Results. Check the Log Results checkbox if the FTP test results are to be 
written to the logfile.

Get/Put Filename. Enter the path and filename of the FTP file. The ellipsis 
button next to the edit box is enabled when Put file to site is selected. Click 
the ellipsis button to navigate to a file.

Default Site Directory. Select Default Site Directory to optionally specify a 
subdirectory on the FTP server.

FTP Run Count.  The FTP run count is the number of times to transfer
the FTP file.

Omit Lows/Highs from Transfer Average. Check this box to eliminate 
outliers from being used in the Transfer Rate Average calculation. Outliers 
are those transmit times lower or higher than the current shortest or longest 
transmit time.

Test Results.  Use the Test Results section of the FTP Test dialog box to view 
the number of Operations, Total Bytes, Rate Average (K/Sec), Rate High, Rate 
Low and Rate Average (Bytes/Sec).

Click Start to begin the throughput test. 
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Chapter 3 Conducting a Size Specific Site 
Survey
Site surveys differ depending on the size of the survey site. Smaller sites are 
surveyed for one or two access points to provide coverage over a space no 
larger than a single room. Medium sized sites could require between 10 and 
20 access points and be the size of a wharehouse or several rooms. Large 
sites could require between 20 and 100 access points and be a large 
building with different radio coverage service areas in different parts of
the building. 

3.1 Conducting a Survey for a Small Area
To conduct a survey in a site where 1 or 2 access points are anticipated:

1. Consult with the designated customer contact person.

Discuss any special installation requirements.  Determine the type of 
cables to be connected to the access points (10 Base T, 10 Base 2,
fiber optic).

2. Document the size and layout of coverage area. 

Document RF systems already in use, location of host system, and 
available AC power.

3. Set up an access point in the middle of the room or where it is estimated 
that the coverage cell will be the largest.

4. Walk the perimeter of the coverage area and measure radio coverage.

For an 11 Mbit direct-sequence network, study round-trip ping times and 
data rates. The individual round-trip ping time is usually about 7 ms 
before the rate changes from 11 Mbits to 5.5 Mbits (using a packet size 
of 1024 bytes). Another set of statistics is obtained by clicking the Test 
Totals button. The Totals dialog displays the number of packets 
transmitted and received and the rates for each. Move the terminal in 
different directions. Position the terminal between the surveyor and
the access point. Do not walk fast or coverage area dead spot could
be missed.
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Depending on the coverage requirements, the perimeter for each of the data 
rates might have to be determined separately. For an FH network, run 100 
pings with a packet size of 512 bytes.  Total test time for 1 Mbit should be 
less than 13 seconds; 12 seconds for 2 Mbit.

5. Mark the location of access points on the blueprint, move the access 
point to the second survey location and repeat the procedure. 

6. Consult with customer technical personnel.

Infrastructure backbone, hubs and patch panels should all be 
documented . Document the conditions existing in the final installation.

7. Complete the Site Survey Report.

The report indicates the number and location of the access points.
Assign  the access points the same channel for each coverage area.

3.2 Conducting a Survey for a Medium Sized Area
To conduct a survey in a site where 10 - 20 access points are anticipated:

1. Consult with the designated customer contact person.

Discuss any special installation requirements.  Determine the type of 
cables to be connected to the access points (10 Base T, 10 Base 2,
fiber optic).

2. Document the size and layout of the coverage area. 

Document RF systems already in use, location of host systems, available 
AC power, possible antenna locations, interfering metal fire breaks and 
wall structures, doorways and passages that could help RF propagation, 
and amount of stock in coverage areas. For a warehouse, document 
how high the stock is kept and how high the lifts go so that the lifts do 
not damage the access points.

3. Set up an access point at one side of the proposed coverage area. 
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4. Walk the perimeter and measure radio coverage. 

If there are multiple floors, measure each floor separately. For an
11 Mbit direct-sequence network, document round-trip times and data 
rates. The individual round-trip ping time is usually about 7 ms before 
the rate changes from 11 Mbits to 5.5 Mbits (using a packet size of
1024 bytes). Move the terminal in different directions. Position the 
terminal between the surveyor and the access point. Do not walk fast
or a radio coverage dead spot might be missed.

5. Document the boundry of each coverage area as the data rates could
be different in aeach area. 

The access point could only be moved a few feet to result in better 
coverage. For 11 Mbit high data rate networks, reflection is more of a 
problem (ceiling sprinklers can cause a problem if the access point 
antenna is less than 2 feet away). For a FH network, run 100 pings with 
a packet size of 512 bytes.  Total test time for 1 Mbit should be less than 
13 seconds; 12 seconds for 2 Mbit.

6. Mark the location of each access point on the blueprint and move the 
access point to different trial location. 

Continue the process until the entire site has radio coverage.

7. Take a picture of at least one access point location for each
coverage area. 

If each coverage area has unique features, take a picture of
eachTake pictures of racks, stock level, hub locations and racks.
The pictures go into the report and help establish the condition
of the site as it was surveyed.

8. Consult with customer technical personnel and document any additional 
hubs that could be required (14  or more access points could require 
multiple hubs). 

Consider exact conditions that exist in the final installation.

9. Complete the Site Survey Report.

The report indicates the number and location of the access points.
Assign  the access points the same channel for each coverage area.
Spectrum24 Site Survey Administrators Guide 47



Conducting a Size Specific Site Survey
3.3 Conducting a Survey for a Large Area 
To conduct a survey in a site where 20 - 100 access points are anticipated:

1. Consult with the designated customer contact person.

Discuss any special installation requirements.  Determine the type of 
cables to be connected to the access points (10 Base T, 10 Base 2,
fiber optic).

2. Document the size and layout of the coverage area. 

Document RF systems already in use, location of host systems, available 
AC power, possible antenna locations, interfering metal fire breaks and 
wall structures, doorways and passages that could help RF propagation, 
and amount of stock in coverage areas. For a warehouse, document 
how high the stock is kept and how high the lifts go so that the lifts do 
not damage the access points.

3. Set up an access point at one side of the proposed coverage area. 

4. Walk the perimeter and measure radio coverage. 

If there are multiple floors, measure each floor separately. For an
11 Mbit direct-sequence network, document round-trip times and data 
rates. The individual round-trip ping time is usually about 7 ms before 
the rate changes from 11 Mbits to 5.5 Mbits (using a packet size of
1024 bytes). Move the terminal in different directions. Position the 
terminal between the surveyor and the access point. Do not walk fast or 
a radio coverage dead spot might be missed.

5. Document the boundary of each coverage area as the data rates could 
be different in each area. 

The access point could only be moved a few feet to result in better 
coverage. For 11 Mbit high data rate networks, reflection is more of a 
problem (ceiling sprinklers can cause a problem if the access point 
antenna is less than 2 feet away). For a FH network, run 100 pings with 
a packet size of 512 bytes. Total test time for 1 Mbit should be less than 
13 seconds; 12 seconds for 2 Mbit.
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Site survey boundary areas for multiple buildings should also be considered 
for large surveys. Determine if a LAN bridge and or wireless access points 
are required.

6. Mark the location of each access point on the blueprint and move the 
access point to different trial location. 

Continue the process until the entire site has radio coverage.

7. Take a picture of at least one access point location for each coverage 
are. 

If each coverage area has unique features, take a picture of each. Take 
pictures of racks, stock level, hub locations and racks. The pictures go 
into the report and help establish the condition of the site as it was 
surveyed.

8. Consult with customer technical personnel and document any additional 
hubs that could be required (14 or more access points could require 
multiple hubs). 

Consider exact conditions that exist in the final installation.

9. Complete the Site Survey Report.

The report indicates the number and location of the access points. Assign 
the access points the same channel for each coverage area.
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Appendix A

Spectrum24 Overview

For applications where mobility and real-time wireless communications are 
essential, Spectrum24 provides high throughput, expandable capacity, 
straightforward installation and superior interface simplicity. Spectrum24 
support for the IEEE 802.11 standard for wireless LANs safeguards a 
Spectrum24 wireless LAN investment by ensuring flexibility and broad 
industry support.

The Symbol Spectrum24 Site Survey utility uses Spectrum24 direct-sequence 
(DS) and frequency-hopping (FS) technology. 

Spectrum24 infrastructure products include:

• bridging architecture to provide communication between radio and 
wired multiple network segments

• a design based on the IEEE 802.11 standard

• roaming for mobile users with devices such as laptops, wireless 
computers, scanning terminals and other computers with PCMCIA slots.

Radio Basics
Spectrum24 devices use both electromagnetic waves and radio signals to 
transmit and receive electric signals without wires. Users communicate with 
the network by establishing radio links between terminals and APs.

Spectrum24 uses FM (frequency modulation) to transmit digital data from 
one device to another. Using FM, a radio signal begins with a carrier signal 
that provides the base or center frequency. The digital data signal is 
superimposed on the carrier signal (modulation). The radio signal 
propagates into the air as electromagnetic waves. A receiving antenna
in the path of the waves absorbs the waves as electrical signals.
The receiving device demodulates the signal by removing the carrier signal. 
This demodulation results in the original digital data.
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Spectrum24 uses the environment (the air and certain objects) as the 
transmission medium. Spectrum24 radio devices transmit in the 2.4 to
2.5-GHz frequency range, a license-free range throughout most of the 
world. The actual range is country-dependent.

Spectrum24 devices, like other Ethernet devices, have unique, hardware-
encoded Media Access Control (MAC) or IEEE addresses. MAC addresses 
determine the device sending or receiving data. A MAC address is a 48-bit 
number written as six hexadecimal bytes separated by colons. For example:

00:A0:F8:24:9A:C8

To locate the AP MAC address see the bottom of the unit.

S24 Network Topology
The variations possible in Spectrum24 network topologies depend on the 
following factors:

• the AP function in the network

• the data transfer rate.

Select from the following topologies:

• A single access point used without the wired network provides a single-
cell wireless network for peer-to-peer MUs.
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• A single access point can bridge the Ethernet and radio networks.

• Multiple access points can coexist as separate, individual networks at the 
same site without interference using different Net_IDs.
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• Multiple access points wired together provide a network with better 
coverage area and performance.

Cellular Coverage
The access point establishes an average communication range with MUs 
called a Basic Service Set (BSS) or cell. When in a particular cell the MU 
associates and communicates with the access point of that cell. Each cell
has a Basic Service Set Identifier (BSS_ID). In 802.11, the access point MAC 
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address represents the BSS_ID. The MU recognizes the access point it 
associates with using the BSS_ID. Adding access points to a LAN establishes 
more cells in an environment, making it an RF Network using the same 
Net_ID or Extended Service Set (ESS).

Access points with the same Net_ID (ESS) define a coverage area. The MU 
searches for access points with a matching Net_ID (ESS) and synchronizes 
with an access point to establish communications. This allows MUs within
the coverage area to move about or roam. As the MU roams from cell to cell, 
it switches access points. The switch occurs when the MU analyzes the 
reception quality at a location and decides which access point to 
communicate with based on the best signal strength and lowest MU
load distribution.

If the MU does not find an access point with an acceptable signal, it performs 
a scan to find any access point. As MUs switch access points, the
access point updates the association table. Roaming is invisible to the user in 
high-level applications.

B SS _ ID

N ET_ID
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Access Point (AP)
The Access Point (AP) provides a bridge between Ethernet wired LANs and 
Spectrum24 wireless networks. It provides connectivity between Ethernet 
wired networks and radio-equipped mobile units (MUs). MUs include the full 
line of Symbol Spectrum24 terminals, PC Cards and PCI adapters, scanners, 
third-party devices and other devices.

The access point monitors Ethernet traffic and forwards appropriate Ethernet 
messages to MUs over the Spectrum24 network. It also monitors MU radio 
traffic and forwards MU packets to the Ethernet LAN.

The access point meets:

• the regulatory requirements for Europe and many other areas of
the world

• FCC part 15, class A with no external shielding

• FCC part 15 class B, ETS 300-339 compliance, including CE mark.

An MU communicating with an access point appears on the network as a 
peer to other network devices. The access point receives data from its wired 
interfaces and forwards the data to the proper interface.

The access point has connections for the wired network, external antennas 
and a power supply. The access point attaches to a wall or ceiling depending 
on installation-site requirements.

The access point requires a single antenna for radio transmission and 
reception. The dual-antenna system option allows the access point to
select the best radio signal.

Advanced Radio Theory
To improve access point management and performance, users need to 
understand basic access point functionality and configuration options.
The access point includes features for different interface connections and 
network management.
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The access point provides MAC layer bridging between its interfaces. The 
access point monitors traffic from its interfaces and, based on frame address, 
forwards the frames to the proper destination. The access point tracks the 
frames sources and destinations to provide intelligent bridging as MUs roam 
or network topologies change. The access point also manages broadcast 
and multicast message initiations and responds to MU association requests.

MAC Layer Bridging
The AP listens to all packets on all interfaces and builds an address database 
using the unique IEEE 48-bit address (MAC address). An address in the 
database includes the interface media that the device uses to associates with 
the access point. The access point uses the database to forward packets from 
one interface to another. The bridge forwards packets addressed to unknown 
systems to the Default Interface (either Ethernet or PPP). Users can use the 
Ethernet interface as a wireless access point interface.

The access point internal stack interface manages all messages directed to 
the access point.
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Each access point stores information on destinations and their interfaces to 
facilitate forwarding. When a user sends an ARP (Address Resolution 
Protocol) request packet, the access point forwards it over all enabled 
interfaces (Ethernet, PPP and radio) except over the interface the ARP request 
packet was received. On receiving the ARP response packet, the access point 
database keeps a record of the destination address along with the receiving 
interface. With this information, the access point forwards any directed 
packet to the correct destination. The access point forwards packets for 
unknown destinations to the Ethernet interface.

ARP request packets received over radio echo back to other access points 
over radio.

The access point removes from its database destinations or interfaces not 
used for a specified time. The access point refreshes its database when it 
transmits or receives data from these destinations and interfaces.

Filtering and Access Control 
The access point provides facilities to limit the MUs that associate with it and 
the data packets that can forward through it. Filters provide network security 
and improve performance by eliminating broadcast/multicast packets from 
the radio network.

The ACL (Access Control List) contains MAC addresses for MUs allowed to 
associate with the access point. This provides security by preventing 
unauthorized access.

The access point uses a disallowed address list of destinations. This feature 
prevents the access point from communicating with specified destinations. 
This can include network devices that do not require communication with the 
access point or its MUs.
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Depending on the setting, the access point can keep a list of frame types that 
it forwards or discards. The Type Filtering option prevents specific frames 
(indicated by the 16-bit DIX Ethernet Type field) from being processed by the 
access point. These include certain broadcast frames from devices 
unimportant to the wireless LAN, but take up bandwidth. Filtering out 
unnecessary frames can improve performance.

DHCP Support
The access point uses Dynamic Host Configuration Protocol (DHCP) to obtain 
a leased IP address and network configuration information from a remote 
server. DHCP is based on BOOTP protocol. DHCP can coexist or interoperate 
with BOOTP. An access point sends out a DHCP request searching for a 
DHCP server to acquire the network configuration and firmware filenames. 
Because BOOTP and DHCP interoperate, the one that responds first 
becomes the server that allocates information. The DHCP client automatically 
sends a DHCP request every XX hours/days to renew the IP address lease as 
long as the access point is running. (This parameter is programmed at the 
DHCP server. Example: Windows NT servers typically are set for 3 days.) 

The access point can download two files when a boot takes place, the 
firmware file and an HTML file, since firmware version 1.00 and above 
supports Web servers. Users can program the DHCP or BOOTP server to 
transfer these two files when a DHCP request is made.

When the access point receives a network configuration change or is not 
able to renew the IP address lease the access point sends out an SNMP trap. 

Media Types
The access point supports bridging between Ethernet, radio and
serial media.

The Ethernet interface fully complies with Ethernet Rev. 2 and IEEE 802.3 
specifications. The access point supports 10Base-T wired connections and 
full-speed filtering. The data transfer rate over radio waves is 11 Mbps.
The Ethernet interface is optional for single-cell or PPP-connected networks.
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The radio interface conforms to IEEE 802.11 specifications. The interface 
operates at 11 Mbps using direct-sequence radio technology. The access 
point supports multiple-cell operations with fast, transparent roaming 
between cells. With the direct-sequence system, each cell operates 
independently. Each cell provides an 11 Mbps bandwidth. Adding cells to the 
network increases coverage area and total system capacity. The access point 
supports MUs operating in Power Save Polling (PSP) mode or Continuously 
Aware Mode (CAM) without user intervention.

The DB-9, 9-pin, RS-232 serial port provides a UI (User Interface) or a PPP 
(Point to Point Protocol) connection. The UI provides basic management tools 
for the access point. The PPP provides a link between APs using a serial 
connection. The serial link supports short haul (direct serial) or long haul 
(telephone-line) connections. The access point is a DTE (Data Terminal 
Equipment) device with male pin connectors for the RS-232 port. Connecting 
the access point to a computer requires a null modem cable and connecting 
the access point to a modem requires a straight-through cable.

Bridging Support
The access point PPP (Point to Point Protocol) interface, accessible from
the serial port at the rear of the access point, provides two types of
bridging operations:
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• Data-link bridging between two access points. A network using a data-
link bridge provides radio coverage by using a remote access point in a 
location geographically distant from the access point connected to the 
Ethernet network. The remote access point cannot provide an Ethernet 
connection to other access points. MUs associating with the remote 
access point transmit and receive from the Ethernet network via the
PPP link.
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• Internet Protocol bridging between an access point and a computer.
To establish an Internet Protocol bridge with an access point, ensure the 
computer includes the appropriate Telnet software with PPP and TCP/IP 
protocols. Using Telnet, a remote computer can connect to any access 
point on an Ethernet network, as long as data transfers through
IP packets.

A PPP link provides the option of using a direct serial link or modem to 
extend wired Ethernet topologies.

Once in PPP mode, the access point automatically attempts to communicate 
with the other device using the Data-Link Bridging (DLB) protocol. An access 
point using DLB communicates on the MAC level, and receives and transmits
Ethernet frames.

If the other device does not support DLB, the access point attempts to 
communicate using Internet Protocol Control Protocol (IPCP). An access point 
using IPCP communicates on the IP level, and receives and transmits IP 
(Internet Protocol) packets. 

The PPP implementation in the access point uses the Link Control Protocol 
(LCP) and Network Control Protocol (NCP) as described in:

• RFC 1171: the Point-to-Point Protocol, July 1990

• RFC 1220: PPP Extensions for Bridging, April 1991
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• RFC 1332: The PPP Internet Protocol Control Protocol, May 1992

• RFC 1661: The Point-to-Point Protocol, July 1994.

RFCs are Requests For Comments used in Internet Communities.

The access point database dynamically tracks MUs and access points on the 
PPP interface. The access point forwards packets to the PPP link after 
determining their destination.

The PPP implementation in the access point uses the NCP as described in 
RFC 1220: PPP Extensions for Bridging to encapsulate packets at the Ethernet 
level. The PPP provides IP bridging control as defined by RFC 1172 and 
MAC-level bridging. It provides support for PPP negotiations conforming to 
RFC 1661. Users cannot plug a non-AP node directly into the access point 
serial port, only AP-to-AP PPP links.

Refer to RFC 1171: The Point to Point Protocol and RFC 1220: PPP Extensions 
for Bridging for information.

PPP Connection
Connecting two access points with a direct serial link requires a null-modem
serial cable.
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Connecting two access points with modem devices requires straight-through 
cables between the access points and modems. Using modems requires a 
telephone line for as long as the link remains active.

When using a modem connection, one access point represents the 
originating access point and the other represents the answering access
point. When using a PPP link, do not use the serial port to access the UI. 
Access to the UI requires establishing a Telnet session with the access point.

Direct-Sequence Spread Spectrum
Spread spectrum (broadband) uses a narrowband signal to spread the 
transmission over a segment of the radio frequency band or spectrum. 
Direct-sequence is a spread spectrum technique where the transmitted
signal is spread over a particular frequency range. The Spectrum24
AP-4111 DS Access Point uses direct-sequence spread spectrum (DSSS) for 
radio communication. 
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Direct-sequence systems communicate by continuously transmitting a 
redundant pattern of bits called a chipping sequence. Each bit of transmitted 
data is mapped into chips by the access point and rearranged into a 
pseudorandom spreading code to form the chipping sequence. The chipping 
sequence is combined with a transmitted data stream to produce the access 
point output signal. 

Mobile units receiving a direct-sequence transmission use the spreading 
code to map the chips within the chipping sequence back into bits to recreate 
the original data transmitted by the access point. Intercepting and decoding 
a direct-sequence transmission requires a predefined algorithm to associate 
the spreading code used by the transmitting access point to the receiving MU. 
This algorithm is established when the access point and MU are configured. 
The bit redundancy within the chipping sequence enables the receiving MU 
to recreate the original data pattern, even if bits in the chipping sequence are 
corrupted by interference. 

The ratio of chips per bit is called the spreading ratio. A high spreading ratio 
increases the resistance of the signal to interference. A low spreading ratio 
increases the bandwidth available to the user. The access point uses two 
chips per bit among three channels within the 2.4 GHz band in a pattern 
Spectrum24 Site Survey Administrators Guide A-15



Spectrum24 Overview
avoiding any 1 or 2 Mbps systems operating in the same area. The access 
point is capable of an 11 Mbps data transmission rate, but the coverage 
area is less than a 1 or 2 Mbps access point since coverage area decreases 
as bandwidth increases. 

Frequency-Hopping Spread Spectrum
Frequency Hopping Spread Spectrum (FHSS) spreads radio signals by 
transmitting a short burst on one frequency, jumping to another frequency 
for another short burst and so on. Spectrum24 uses the 2.4 - 2.5 GHz range 
depending on the country, this range does not require licensing from the 
FCC. FHSS offers a higher transmission rate than a conventional radio 
narrowband method. Spectrum24 access points, with the exception of the 
AP-4111 DS Access Point, use frequency-hopping spread spectrum. 

In FHSS systems, the carrier frequency of the transmitter changes (or hops) in 
accordance with the pseudo-random code sequence. The code sequence 
dictates the frequency order selected by the transmitter. The transmitter takes 
the input data and spreads it in a predefined method. Each receiver has to 
understand this predefined method and reconstruct the signal before 
interpreting data. Stations in a cell using FHSS techniques hop or change the 
carrier frequency at synchronized intervals. Government regulatory agencies 
and standards, such as ETSI, MKK, the FCC and IEEE 802.11, determine the 
number of frequency hops (79 for the U.S.), the hopping pattern (sequence 
each frequency is used) and dwell time (time at each frequency). The FCC 
requires 75 or more hopping frequencies used and a maximum of 400ms 
for dwell time per frequency. The transmitter and receiver synchronize to
the hop sequence to ensure communication. The time synchronization
field included in message packets coordinates the hop timing of all units.
The user can program the length each hop lasts. Each hop is a frequency at 
least 6 MHz away from the previous frequency and has a 1 MHz bandwidth.
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FHSS can survive in an adverse environment and coexist with other devices/
services in the same band. The average signal strength being relatively low 
on any given frequency is a result of FHSS. When the signal intelligence is 
spread out over several MHz in the frequency spectrum, the resulting power 
spectrum also spreads out (less than 1 watt). This results in the transmitted 
power spread out over a wide frequency bandwidth and makes detection 
very difficult (with out the code sequence). 

Hopping provides enhanced data reception in the presence of interfering 
signals, like fixed frequency radio networks or microwave ovens. The system 
also resists interference because it spends a short time on each given 
frequency. If an interfering source is present (interference at a specific 
frequency), only a small number of frequency hops are blocked instead of 
the entire range. With interference occurring on one frequency, the data is 
retransmitted on a subsequent hop at another frequency. Even if constant 
interference exists on a given frequency, it affects the radio network for only a 
short time on that specific frequency. Although access points can share the 
same hopping sequence, they usually do not synchronize in time. Rarely do 
they simultaneously arrive at the same frequency, referred to as contention. 
Interfering signals can reduce overall throughput at some frequencies. This 
reduces the probability and impact of overlapping frequencies or collisions. 
Although devices can hop to the same frequency, they eventually hop to 
different frequencies after the hop time.

With Spectrum24, each access point on the local network negotiates a 
different hopping sequence at start-up. This allows access points to provide 
frequency separation and evenly divide the frequency spectrum among
the units.

MU Association Process
Access points recognize MUs as they associate with the access point. The 
access point keeps a list of the MUs it services. MUs associate with an access 
point based on the following conditions:

• the signal strength between the access point and MU

• the MUs currently associated with the access point
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• the MU Supported Rate (see table below). 

MUs perform preemptive roaming by intermittently scanning for access 
points and associating with the best available access point. Before roaming 
and associating with access points, MUs perform full or partial scans to 
collect access point statistics and determine the direct-sequence channel used 
by the access point.

Scanning is a periodic process where the MU sends out probe messages on 
all frequencies defined by the country code. The statistics enable an MU to 
reassociate by synchronizing its frequency to the access point. The MU 
continues communicating with that access point until it needs to roam 
between cells.

MUs perform full scans at start-up. In a full scan, an MU uses a sequential set 
of channels as the scan range. For each channel in range, the MU tests for 
CCA (Clear Channel Assessment). When a transmission-free channel 
becomes available, the MU broadcasts a probe with the Net_ID and the 
broadcast BSS_ID. An AP-directed probe response generates an MU ACK 
(Mobile Unit Acknowledgment) and the addition of the access point to the 
access point table with a proximity classification. An unsuccessful access 
point packet transmission generates another MU probe on the same 
channel. If the MU fails to receive a response within the time limit, it repeats 
the probe on the next channel in the sequence. This process continues 
through all channels in the range.

MUs perform partial scans at programmed intervals, when missing expected 
beacons or after excessive transmission retries. In a partial scan, the MU 
scans access points classified as proximate on the access point table. For 
each channel, the MU tests for CCA. The MU broadcasts a probe with the 
Net_ID and broadcast BSS_ID when the channel is transmission-free. It sends 
an ACK to a directed probe response from the access point, and updates the 

Data Rate Requirement

 11 Mbps Optional

 5.5 Mbps Optional

 2 Mbps Optional

 1 Mbps Required
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access point table. An unsuccessful access point packet transmission causes 
the MU to broadcast another probe on the same channel. The MU classifies 
an access point as out-of-range in the access point table if it fails to receive a 
probe response within the time limits. This process continues through all 
access points classified as proximate on the access point table.

An MU can roam within the coverage area by switching access points. 
Roaming is transparent and virtually instantaneous in high-level applications. 
Roaming occurs when:

• an unassociated MU attempts to associate or reassociate with an 
available access point

• the supported rate changes or the MU finds a better transmit rate with 
another access point

• the RSSI (received signal strength indicator) of a potential access point 
exceeds the current access point

• the ratio of good-transmitted packets to attempted-transmitted packets 
falls below a threshold

• the MU detects an imbalance in the number of MUs associated with 
available access points and roams to a less loaded access point.

An MU selects the best available access point and adjusts itself to the access 
point direct-sequence channel to begin association. Once associated, the 
access point begins forwarding any frames it receives addressed to the MU. 
Each frame contains fields for the current direct-sequence channel. The MU 
uses these fields to resynchronize to the access point.

Mobile IP 
The Internet Protocol identifies the MU point of attachment to a network 
through its IP address. The access point routes packets according to the 
location information contained in the IP header. If the MU roams across 
routers to another subnet, the following situations occur:

• The MU changes its point of attachment without changing its IP address, 
causing forthcoming packets to become undeliverable.

• The MU changes its IP address when it moves to a new network, causing 
it to lose connection.
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Mobile IP enables an MU to communicate with other hosts using
only its home IP address after changing its point-of-attachment to the 
internet/intranet.

Mobile IP is like giving an individual a local post office forwarding address 
when leaving home for an extended period. When mail arrives for the 
individual home address, it is forwarded by the local post office to the current 
care-of-address. Using this method, only the local post office requires 
notification of the individual current address. While this example represents 
the general concept of Mobile IP operation and functionality, it does not 
represent the implementation of Mobile IP used.

A tunnel is the path taken by the original packet encapsulated within the 
payload portion of a second packet to some destination on the network.

A Home Agent is an access point acting as a router on the MU home 
network. The home agent intercepts packets sent to the MU home address 
and tunnels the message to the MU at its current location. This happens as 
long as the MU keeps its home agent informed of its current location on 
some foreign link.

A Foreign Agent is an access point acting as a router at the MU location on a 
foreign link. The foreign agent serves as the default router for packets sent 
out by the MU connected on the same foreign link.

A care-of-address is the IP address used by the MU visiting a foreign link. 
This address changes each time the MU moves to another foreign link. It can 
also be viewed as an exit point of a tunnel between the MU home agent and 
the MU itself.

The S24 Mobile IP (roaming across routers) feature enables an MU on
the Internet to move from one subnet to another while keeping its IP
address unchanged.

To configure Mobile IP, see the Product Reference Guide included with the 
access point.
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The scanning and associating process continues for active MUs. This allows 
the MUs to find new access points and discard out-of-range or deactivated 
access points. By testing the airwaves, the MUs can choose the best network 
connection available.

The following diagram illustrates Mobile IP (roaming across routers):

Set the MU for Mobile IP as specified in the MU user documentation.

Security has become a concern to mobile users. Enabling the Mobile-Home 
MD5 key option in the System Configuration menu generates a 16-byte 
checksum authenticator using an MD5 algorithm. The MU and access point 
share the checksum, called a key, to authenticate transmitted messages 
between them. The access point and MU share the key while the MU is 
visiting a foreign subnet. The MU and AP have to use the same key. If not, the 
access point refuses to become the Home Agent for the MU. The maximum 
key length is 13 characters. The access point allows all printable characters.
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Supporting CAM and PSP Stations
CAM (Continuously Aware Mode) stations leave their radios on continuously 
to hear every beacon and message transmitted. These systems operate 
without any adjustments by the access point. A beacon is a uniframe system 
packet broadcast by the access point to keep the network synchronized. A 
beacon includes the Net_ID (ESS), the access point address, the Broadcast 
destination addresses, a time stamp, a DTIM (Delivery Traffic Indicator Maps) 
and the TIM (Traffic Indicator Message).

PSP (Power Save Polling) stations power off their radios for long periods. 
When a Spectrum24 MU in PSP mode associates with an access point, it 
notifies the access point of its activity status. The access point responds by 
buffering packets received for the MU. The Spectrum24 adapters use a PSP 
performance index from1 to 5, where 1 provides the quickest response time 
and 5 provides the most efficient power consumption. 

The performance index determines how long the adapter stays in CAM after 
transmit or receive activity. Regardless of the performance index used, 
adapters switch to CAM for data reception/transmission. The awake interval 
in PSP performance index 1 is long enough to allow for round-trip packet 
response times. The packet response time in PSP performance index 5 is only 
25 msec, the adapter goes back to sleep and requires another wake up 
period to receive data.

When the MU wakes up and sees its bit set in the TIM, it issues a short frame 
to the access point for the packets stored. The access point sends them to the 
MU and the MU issues another short frame when the data has been received 
and is ready to go back to PSP. A DTIM field, also called a countdown field, 
informs MUs of the next window for listening to broadcast and multicast 
messages. When the access point has buffered broadcast or multicast 
messages for associated MUs, it sends the next DTIM with a DTIM Interval 
value. To prevent a PSP-mode MU from sleeping through a DTIM notification, 
select a PSP mode value less than or equal to the DTIM value. PSP-mode
MUs hear the beacons and awaken to receive the broadcast and
multicast messages. 
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A TIM is a compressed virtual bitmap identifying the access point associated 
MUs in PSP mode that have buffered directed messages. MUs issue a poll 
request when access points issue a TIM. A beacon with the broadcast-
indicator bit set causes the MU to note DTIM Count field value. The value 
informs the MU of the beacons remaining before next DTIM. This ensures
the MU turns on the receiver for the DTIM and the following BC/MC
packet transmissions.

Data Encryption
Spectrum24 devices operating on a wired or wireless network face possible 
information theft. This occurs when an unauthorized user eavesdrops on 
someone else to obtain information illegally. The absence of a physical 
connection makes wireless links particularly vulnerable to this form of theft. 
Encryption becomes the most efficient method in preventing information 
theft and improving data security. Encryption entails scrambling and coding 
information, typically with mathematical formulas called algorithms, before 
the information is transmitted over a network. An algorithm is a set of 
instructions or formula for scrambling the data. A key is the specific code 
used by the algorithm to encrypt or decrypt the data. Decryption is the 
decoding and unscrambling of received encrypted data. The same device, 
host computer or front-end processor, usually performs both encryption
and decryption. The data transmit or receive direction determines whether 
the encryption or decryption function is performed. This device takes the 
plain text and scrambles or encrypts it and transmitting the data over the 
network, typically by mathematically combining the key with the plain text
as prescribed by the algorithm. At the receiving end another device takes the 
encrypted text and decrypts, unscrambles, the text resulting in the original 
plain text. An authorized user can know the algorithm, but cannot interpret 
the encrypted data without the appropriate key. Only the sender and receiver 
of the transmitted data know the key.

Symbol uses the Wired Equivalent Privacy (WEP) algorithm, specified in
IEEE 802.11 section 8, for encryption and decryption. WEP uses the same
key for both encrypting and decrypting plain text. Typically an external key 
management service distributes the key. Users should change the key often 
for added security. By default, IEEE 802.11 devices operate in an open 
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system network where any wireless device can associate with an access point 
without authorization. A wireless device with a valid Encryption key is allowed 
to associate with the access point. Authentication management messages 
(packets) are unicast, meaning authentication messages transmit from one 
access point to one MU only, not broadcast or multicast.

HTTP, HTML Web Server Support
Hypertext Transfer Protocol (HTTP) is the native language of the Web.
The HTTP protocol makes requests from browsers (the user) to servers and 
responses from servers to browsers. This function provides the user with a 
Web-based format for configuration and firmware download. 

Web pages are written in HTML (Hypertext Markup Language.) HTML allows 
the user to create web pages containing text, graphics and pointers or links 
to other web pages or elsewhere on the page or document. Pointers are 
known as Uniform Resource Locators (URLs). A URL is essentially the name of 
the web page. The URL consists of three parts:

• the protocol (a scheme)

• the DNS (Domain Name Server) the machine where the page is located

• the local name that identifies the page (usually the file name).

The HTML language describes how to format the document. Much like a 
copyeditor describes which fonts to use, such as the location, color, header 
size and text. 

Management Options
Managing Spectrum24 includes viewing network statistics and setting 
configuration options. Statistics track the network activity of associated MUs 
and data transfers on the access point interfaces. Configuration involves 
setting system operating parameters and filters used in bridging.

The access point requires one of the following to perform a custom 
installation or maintain the Spectrum24 network:

• SNMP (Simple Network Management Protocol)

• wired LAN workstation with a Telnet client

• terminal or PC with RS-232 connection and ANSI emulation
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Changing one access point does not affect the configuration of other access 
points on the network. Make configuration changes to access points 
individually. Each access point requires an individual IP address.

Programmable SNMP Trap Support
The SNMP defines the method for obtaining information about networks 
operating characteristics and changing router and gateway parameters. 
SNMP consists of three elements:

• management stations 

• management information

• a management protocol.

Nodes can perform as hosts, routers, bridges or other devices that can 
communicate status information. An SNMP Agent is a node that runs the 
SNMP management process to systematically monitor and manage the 
network. The management station performs network management by 
running application management software.

An SNMP trap is an alert to all configured management stations of some 
significant event that occurred on the network. The management station 
queries all stations for details of each specific event, including what, when 
and where the event took place and the current status of the node or 
network. The format or structure is defined in SNMP. The MIB defines what 
and who monitors the variables.

Using SNMP
The access point includes SNMP agent versions accessible via an SNMP 
manager application such as, HP Open View or Cabletron Spectrum MIB 
browser. The SNMP agent supports SNMP versions 1 and 2, MIB II, the 
802.11 MIB and one Symbol proprietary Symbol MIB (Management 
Information Base). The SNMP agent supports read-write, read-only or 
disabled modes. The access point supports traps that return to the SNMP 
manager when certain events occur. The Wireless LAN Installation and 
Utilities disk packaged with MUs contains the MIB.
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Increased MIB Support
The MIB defines what the management station needs to understand and 
which objects the station manages. The MIB has ten categories defined with 
approximately 175 variables.

Using the UI
The UI (User Interface) is a text-based maintenance tool integrated into the 
access point. It provides statistical displays, access point configuration 
options and firmware upgrades. Access to the UI requires one of
the following:

For instructions on adjusting the access point configuration options refer to 
the Product Reference Guide included with the access point.

Telnet Client Gain access to the access point built-in Telnet server 
from any access point interface including remote 
Ethernet connections. 

Direct Serial 
Connection

Acts as a DTE device to connect directly to a DTE device with 
a null-modem serial cable. The direct serial access method 
requires a communication program with
ANSI emulation. 

Dial Up Access The dial-up access method requires a communication 
program with ANSI emulation on the remote terminal
or PC. The terminal or PC dials to an access point with a 
modem connection. The access point supports connection 
to a Hayes-compatible 28,800-baud or faster modem. 

SNMP Via a MIB 
Browser

Gain access to the access point SNMP function via a MIB 
Browser. Typically a Network Manager uses this feature, 
Symbol does not recommend access point access using this 
interface method. Refer to the MIB Browser documentation 
for usage.

Web Browser Gain access to the access point built-in Web server from 
any access point interface including remote 
Ethernet connections. 
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Appendix B

Customer Support

Symbol Technologies provides its customers with prompt 
and accurate customer support. Use the Symbol 
Support Center as the primary contact for any technical 
problem, question or support issue involving Symbol 
products.

If the Symbol Customer Support specialists cannot solve 
a problem,
access to all technical disciplines within Symbol 
becomes available for further assistance and support. 
Symbol Customer Support responds to calls by email, 
telephone or fax within the time limits set forth in 
individual contractual agreements.

When contacting Symbol Customer Support, please 
provide the following information:

• serial number of unit

• model number or product name

• software type and version number.

North American Contacts

Inside North America, contact Symbol by:

• Symbol Technologies, Inc.
One Symbol Plaza
Holtsville, New York 11742-1300
Telephone: 1-516-738-2400/1-800-SCAN 234
Fax: 1-516-738-5990 
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Customer Support
• Symbol Support Center: 

– telephone: 1-800-653-5350

– fax: (516) 563-5410

– Email: support@symbol.com

International Contacts
Outside North America, contact Symbol by:

• Symbol Technologies Technical Support
12 Oaklands Park
Berkshire, RG41 2FD, United Kingdom
Tel: 011-44-118-945-7000 or 1-516-738-2400
ext. 6213

Symbol Developer Program Web Site
http://sdp.symbol.com

Additional Information
Obtain additional information by contacting Symbol at:

• 1-800-722-6234, inside North America 

• +1-516-738-5200, in/outside North America

• http://www.symbol.com
B-2 Spectrum24 Site Survey Administrators Guide

http://www.symbol.com
http://sdp.symbol.com


Appendix C

Regulatory Compliance

To comply with U.S. and international regulatory requirements, the following 
information has been included. The document applies to the complete line of 
Symbol products. Some of the labels shown, and statements applicable to 
other devices might not apply to all products.

Radio Frequency Interference Requirements
This device has been tested and found to comply with the limits for a
Class A digital device pursuant to Part 15 of the Federal Communications 
Commissions Rules and Regulation. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense.

However, there is no guarantee that interference will not occur in a particular 
installation. If the equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Re-orient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that 
which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.
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Regulatory Compliance
Radio Frequency Interference Requirements - Canada
This Class A digital apparatus meets the requirements of the Canadian
Interference-Causing Equipment Regulations.

CE Marking & European Union Compliance
Products intended for sale within the European Union are marked 
with the CEMark which indicates compliance to applicable Directives 
and European Normes (EN), as follows. Amendments to these 
Directives or ENs are included: Normes (EN), as follows.

Applicable Directives:
• Electromagnetic Compatibility Directive 89/336/EEC

• Low Voltage Directive 73/23/EEC

Applicable Standards:
• EN 55 022 - Limits and Methods of Measurement of Radio Interference 

Characteristics of Information technology Equipment

• EN 50 082-1 - Electromagnetic Compatibility - Generic Immunity 
Standard, Part 1: Residential, commercial, Light Industry

• IEC 801.2 - Electromagnetic Compatibility for Industrial Process 
Measurement and Control Equipment Part 2: Electrostatic
Discharge Requirements

• IEC 801.3 - Electromagnetic Compatibility for Industrial Process 
Measurement and Control Equipment Part 3: Radiated 
Electromagnetic Field Requirements

• IEC 801.4 - Electromagnetic Compatibility for Industrial Process 
Measurement and Control Equipment Part 4: Electrical Fast
Transients Requirements

• EN 60 950 + Amd 1 + Amd 2 - Safety of Information Technology 
Equipment Including Electrical Business Equipment

• EN 60 825-1 (EN 60 825) - Safety of Devices Containing Lasers 
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Regulatory Compliance
RF Devices
Symbol’s RF products are designed to be compliant with the rules and
regulations in the locations into which they are sold and will be labeled as 
required. The majority of Symbol’s RF devices are type approved and
do not require the user to obtain license or authorization before using the 
equipment. Any changes or modifications to Symbol Technologies
equipment not expressly approved by Symbol Technologies could void the 
user’s authority to operate the equipment.

Telephone Devices (Modems)
United States

If this product contains an internal modem it is compliant with Part 68 of the 
Federal Communications Commission Rules and Regulations and there will 
be a label on the product showing the FCC ID Number and the REN,
Ringer Equivalence Number.   The REN is used to determine the quantity
of devices which maybe connected to the telephone line. Excessive RENs on 
the telephone line may result in the device not ringing in response to an 
incoming call. In most but not all areas, the sum of the RENs should not 
exceed 5.0. To be certain of the number of devices that may be connected to 
the line, as determined by the total number of RENs, contact the telephone 
company to determine the maximum REN for the calling area.

If the modem causes harm to the telephone network, the telephone company 
will notify you in advance; however, if advance notice is not practical, you will 
be notified as soon as possible. Also, you will be advised of your right to file 
a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, 
operations or procedures that could affect the operation of the modem.
If this happens the telephone company will provide advance notice so you 
may make any necessary modifications to maintain uninterrupted service.
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Regulatory Compliance
Canada
If this product contains an internal modem it is compliant with CS-03 of 
Industry Canada and there will be a Canadian certification number 
(CANADA:            ) on a label on the outside of the product. This certification 
means that the equipment meets certain telecommunications network 
protective, operational and safety requirements. The Department does not 
guarantee the equipment will operate to the user’s satisfaction.

Before installing this equipment, users should ensure that it is permissible to 
be connected to the facilities of the local telecommunications company. The 
equipment must also be installed using an acceptable method of connection. 
In some cases, the company’s inside wiring associated with a single-line, 
individual service maybe extended by means of a certified convector 
assembly (telephone extension cord). The customer should be aware that 
compliance with the above conditions may not prevent degradation of 
service in some situations.

Repairs to certified equipment should be made by an authorized Canadian 
maintenance facility designated by the supplier. Any repairs or alterations 
made by the user to this equipment, or equipment malfunctions, may give 
the telecommunications company cause to request the user to disconnect
the equipment.

User should ensure for their own protection that the electrical ground 
connections of the power utility, telephone lines and internal metallic water 
pipe system, if present, are connected together. This precaution may be 
particularly important in rural areas.

Do not attempt to make such connections themselves, but
should contact the appropriate electric inspection authority, or electrician,
as appropriate.
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Regulatory Compliance
The Load Number (LN) assigned to each terminal device denotes the 
percentage of the total load to be connected to the telephone loop which is 
used by the device, to prevent overloading. The termination of a loop may 
consist of any combination of devices, subject only to the requirement that 
the total of the Load Numbers of all devices not exceed 100.

The Load Number is located on a label on the product.

Contact your local Symbol Technologies, Inc., representative for service
and support;

Symbol Technologies, Inc.,
Canadian Sales and Service
2540 Matheson Boulevard East
Mississauga, Ontario
Canada L4W 4Z2
Phone - 905 629 7226

Laser Devices
Symbol products using lasers comply with US 21CFR1040.10, Subchapter J 
and IEC825/EN 60 825 (or IEC825-1/EN 60 825-1, depending on the date 
of manufacture). The laser classification is marked one of the labels on
the product.

Class 1 Laser devices are not considered to be hazardous when used for 
their intended purpose. The following statement is required to comply with 
US and international regulations:

Use of controls, adjustments or performance of procedures other than
those specified herein may result in hazardous visible or invisible laser
light exposure.

Class 2 laser scanners use a low power, visible light diode. As with any
very bright light source, such as the sun, the user should avoid staring directly 
into the light beam. Momentary exposure to a Class 2 laser is not known to 
be harmful.
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